
CCC PLUS EXAMINATION
Advanced Question Bank

Computer Fundamentals (Advanced)

1. Which component resolves the bottleneck in von Neumann architecture by
separating instruction and data caches?

a) Northbridge

b) Harvard architecture

c) BIOS

d) ALU

Answer: b) Harvard architecture

2. If a 32-bit system uses 4 KB pages, how many entries are needed in a flat page
table for full virtual address space?

a) 1,048,576

b) 1,024

c) 4,096

d) 16,777,216

Answer: a) 1,048,576

3. Which memory type is used in SSDs for persistent storage?

a) DRAM

b) SRAM

c) NAND Flash

d) EEPROM

Answer: c) NAND Flash

4. What is the primary purpose of ECC memory?

a) Increase speed

b) Reduce power consumption

c) Detect and correct bit errors

d) Enable overclocking

Answer: c) Detect and correct bit errors

5. In binary, what is the two’s complement of 0101?
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a) 1010

b) 1011

c) 0101

d) 1111

Answer: b) 1011

6. Which bus connects CPU to RAM in modern systems?

a) PCIe

b) SATA

c) Front Side Bus (FSB)

d) DMI

Answer: c) Front Side Bus (FSB)

7. A nibble can represent values from:

a) 0 to 7

b) 0 to 15

c) 0 to 255

d) -8 to +7

Answer: b) 0 to 15

8. Which generation introduced microprocessors?

a) First

b) Second

c) Third

d) Fourth

Answer: d) Fourth

9. RAID 1 provides:

a) Striping

b) Mirroring

c) Parity

d) Compression

Answer: b) Mirroring

10. What does BIOS do during POST?

a) Loads OS from disk

b) Checks hardware functionality

c) Connects to Wi-Fi

d) Runs antivirus scan
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Answer: b) Checks hardware functionality
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Operating System and File Management (Advanced)

11. What is the key difference between a process and a thread?

a) Threads share memory; processes do not

b) Processes are faster

c) Threads cannot be scheduled

d) Processes use less RAM

Answer: a) Threads share memory; processes do not

12. Which file system supports file-level encryption in Windows?

a) FAT32

b) exFAT

c) NTFS

d) ext4

Answer: c) NTFS

13. What happens when you delete a file using Shift + Delete in Windows?

a) It goes to Recycle Bin

b) It is permanently deleted but recoverable via tools

c) It is encrypted

d) It is moved to cloud

Answer: b) It is permanently deleted but recoverable via tools

14. Virtual memory uses:

a) Cache only

b) Hard disk as extension of RAM

c) GPU memory

d) ROM

Answer: b) Hard disk as extension of RAM

15. Which command lists all files including hidden ones in Linux?

a) ls

b) dir

c) ls -a

d) list /all

Answer: c) ls -a

16. What is the purpose of a swap file?
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a) Store temporary internet files

b) Extend virtual memory

c) Backup user data

d) Compress disk space

Answer: b) Extend virtual memory

17. In Windows, which folder stores user-specific application data?

a) Program Files

b) AppData

c) System32

d) Temp

Answer: b) AppData

18. What does defragmentation do?

a) Deletes duplicate files

b) Reorganizes fragmented data for faster access

c) Encrypts files

d) Compresses disk

Answer: b) Reorganizes fragmented data for faster access

19. Which key combination opens Task Manager directly?

a) Ctrl + Alt + Del

b) Ctrl + Shift + Esc

c) Alt + F4

d) Win + R

Answer: b) Ctrl + Shift + Esc

20. What is the default permission for a new file in Linux?

a) 777

b) 644

c) 666

d) 755

Answer: b) 644
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Word Processing (Advanced)

21. Which feature allows automatic updating of figure captions in Writer/Word?

a) Mail Merge

b) Cross-reference

c) Styles

d) Table of Contents

Answer: b) Cross-reference

22. What does “Keep with next” paragraph setting do?

a) Prevents page break between paragraph and next

b) Copies paragraph to next page

c) Links to next document

d) Deletes next paragraph

Answer: a) Prevents page break between paragraph and next

23. Which file format preserves formatting across platforms best?

a) .txt

b) .doc

c) .odt

d) .pdf

Answer: d) .pdf

24. What is the purpose of “Track Changes”?

a) Monitor document size

b) Record edits for review

c) Auto-save every change

d) Encrypt changes

Answer: b) Record edits for review

25. How do you insert a non-breaking space in Writer?

a) Ctrl + Space

b) Ctrl + Shift + Space

c) Alt + Space

d) Insert → Special Character

Answer: b) Ctrl + Shift + Space

26. Which style controls the appearance of headings in TOC?
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a) Body Text

b) Heading 1, Heading 2, etc.

c) Caption

d) Default

Answer: b) Heading 1, Heading 2, etc.

27. What does “Orphan control” prevent?

a) Single line at bottom of page

b) Single line at top of page

c) Blank pages

d) Image overflow

Answer: b) Single line at top of page

28. Which menu contains “Footnotes and Endnotes”?

a) Edit

b) Insert

c) Format

d) Tools

Answer: b) Insert

29. What is the shortcut to paste without formatting?

a) Ctrl + V

b) Ctrl + Shift + V

c) Alt + V

d) Ctrl + Alt + V

Answer: b) Ctrl + Shift + V

30. Which feature converts handwritten notes to text in modern Word?

a) OCR

b) Ink to Text

c) Smart Lookup

d) Dictation

Answer: b) Ink to Text
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Spreadsheet (Advanced)

31. What does =VLOOKUP(100, A1:D10, 3, FALSE) return if 100 is not found?

a) 0

b) #N/A

c) Blank

d) Last value

Answer: b) #N/A

32. Which function counts non-blank cells?

a) COUNT

b) COUNTA

c) COUNTBLANK

d) SUM

Answer: b) COUNTA

33. What is absolute referencing?

a) Using $A$1 to lock cell reference

b) Linking to another sheet

c) Copying values only

d) Using named ranges

Answer: a) Using $A$1 to lock cell reference

34. Which error appears if a formula divides by zero?

a) #VALUE!

b) #REF!

c) #DIV/0!

d) #NAME?

Answer: c) #DIV/0!

35. What does =IFERROR(A1/B1, "Error") do?

a) Returns “Error” if division fails

b) Stops calculation

c) Highlights cell red

d) Logs error in another sheet

Answer: a) Returns “Error” if division fails

36. Which chart best shows part-to-whole relationship?
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a) Line

b) Bar

c) Pie

d) Scatter

Answer: c) Pie

37. What is the result of =ROUND(3.14159, 2)?

a) 3.14

b) 3.142

c) 3

d) 3.1

Answer: a) 3.14

38. How do you freeze the top row in Calc/Excel?

a) View → Freeze Panes

b) Format → Lock Row

c) Tools → Freeze

d) Right-click → Freeze

Answer: a) View → Freeze Panes

39. What does =SUMIF(A1:A10, ">50", B1:B10) do?

a) Sums B1:B10 where A1:A10 > 50

b) Counts cells >50

c) Multiplies A and B

d) Averages B1:B10

Answer: a) Sums B1:B10 where A1:A10 > 50

40. Which format code shows 1500 as “1.5K”?

a) 0.0,"K"

b) #,##0

c) 0.00E+00

d) Not possible

Answer: a) 0.0,"K"
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Internet and Communication (Advanced)

41. Which protocol encrypts HTTP traffic?

a) FTP

b) SMTP

c) HTTPS

d) DNS

Answer: c) HTTPS

42. What does a DNS server do?

a) Assigns IP addresses

b) Converts domain names to IP addresses

c) Filters spam

d) Hosts websites

Answer: b) Converts domain names to IP addresses

43. Which port does HTTPS use by default?

a) 80

b) 443

c) 25

d) 21

Answer: b) 443

44. What is a cookie in web browsing?

a) A virus

b) Small data stored by website on user’s device

c) A type of ad

d) Browser setting

Answer: b) Small data stored by website on user’s device

45. Which is NOT a valid IPv4 address?

a) 192.168.1.1

b) 255.255.255.255

c) 300.40.50.60

d) 127.0.0.1

Answer: c) 300.40.50.60

46. What is the purpose of incognito mode?
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a) Hide IP address

b) Prevent local storage of history/cookies

c) Encrypt traffic

d) Block ads

Answer: b) Prevent local storage of history/cookies

47. Which technology enables real-time video calls over the internet?

a) VoIP

b) FTP

c) SMTP

d) POP3

Answer: a) VoIP

48. What is a QR code phishing attack called?

a) Smishing

b) Vishing

c) Quishing

d) Pharming

Answer: c) Quishing

49. Which header field prevents clickjacking?

a) Content-Type

b) X-Frame-Options

c) Cache-Control

d) User-Agent

Answer: b) X-Frame-Options

50. What does CDN stand for?

a) Central Data Network

b) Content Delivery Network

c) Computer Distribution Node

d) Cloud Data Node

Answer: b) Content Delivery Network
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Digital Financial Services & Cybersecurity (Advanced)

51. Which UPI feature allows recurring payments?

a) UPI Collect

b) UPI AutoPay

c) UPI Lite

d) UPI QR

Answer: b) UPI AutoPay

52. What is the maximum transaction limit per UPI transaction (as of 2024)?

a) ₹10,000

b) ₹1,00,000

c) ₹2,00,000

d) ₹5,00,000

Answer: b) ₹1,00,000

53. Which attack tricks users into revealing OTPs via fake customer care calls?

a) Phishing

b) Vishing

c) Smishing

d) Ransomware

Answer: b) Vishing

54. What does 2FA stand for?

a) Two-Factor Authentication

b) Two-Factor Authorization

c) Two-Factor Access

d) Two-Factor Agreement

Answer: a) Two-Factor Authentication

55. Which is a secure practice for UPI?

a) Share UPI PIN with family

b) Use public Wi-Fi for payments

c) Never share OTP or UPI PIN

d) Save UPI PIN in notes

Answer: c) Never share OTP or UPI PIN

56. What is the purpose of a digital signature?
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a) Compress files

b) Verify authenticity and integrity

c) Encrypt passwords

d) Speed up transactions

Answer: b) Verify authenticity and integrity

57. Which law governs digital transactions in India?

a) IPC

b) IT Act, 2000

c) RBI Act

d) Consumer Protection Act

Answer: b) IT Act, 2000

58. What is ransomware?

a) Software that encrypts files and demands payment

b) Adware

c) Browser extension

d) Antivirus

Answer: a) Software that encrypts files and demands payment

59. Which is NOT a principle of cybersecurity?

a) Confidentiality

b) Integrity

c) Availability

d) Profitability

Answer: d) Profitability

60. What should you do if you receive a suspicious UPI collect request?

a) Approve it quickly

b) Ignore and report

c) Share with friends

d) Call the number in request

Answer: b) Ignore and report
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General & Emerging Technologies

61. What is cloud storage?

a) Storing data on remote servers accessed via internet

b) Using USB drives

c) Saving on desktop

d) Printing documents

Answer: a) Storing data on remote servers accessed via internet

62. Which is a risk of public Wi-Fi?

a) Slow speed

b) Man-in-the-middle attacks

c) High cost

d) Limited apps

Answer: b) Man-in-the-middle attacks

63. What does AI bias refer to?

a) AI running slowly

b) Unfair outcomes due to skewed training data

c) AI not connecting to internet

d) High electricity usage

Answer: b) Unfair outcomes due to skewed training data

64. Which service offers free cloud storage from Google?

a) OneDrive

b) iCloud

c) Google Drive

d) Dropbox Basic

Answer: c) Google Drive

65. What is biometric authentication?

a) Password-based login

b) Using fingerprint, face, or iris

c) SMS verification

d) Security questions

Answer: b) Using fingerprint, face, or iris

66. What is the main advantage of open-source software?
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a) Free to use and modify

b) Better graphics

c) Always virus-free

d) Faster than proprietary

Answer: a) Free to use and modify

67. Which is an example of SaaS?

a) Windows OS

b) Gmail

c) LibreOffice

d) Ubuntu

Answer: b) Gmail

68. What is digital footprint?

a) Physical shoe print

b) Data trail left by online activity

c) File size

d) Screen resolution

Answer: b) Data trail left by online activity

69. Which practice enhances online privacy?

a) Using same password everywhere

b) Enabling two-factor authentication

c) Clicking unknown links

d) Sharing location publicly

Answer: b) Enabling two-factor authentication

70. What is ethical hacking?

a) Stealing data

b) Hacking with permission to find vulnerabilities

c) Creating viruses

d) Spamming emails

Answer: b) Hacking with permission to find vulnerabilities
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Scenario-Based & Application Questions

71. You receive an email claiming your bank account is locked and asking you to click
a link to verify. What should you do?

a) Click the link immediately

b) Forward to friends

c) Delete and report as phishing

d) Call the number in the email

Answer: c) Delete and report as phishing

72. In a spreadsheet, sales data from Jan–Dec is in B2:B13. Which formula calculates
average sales?

a) =SUM(B2:B13)

b) =AVERAGE(B2:B13)

c) =MEAN(B2:B13)

d) =TOTAL(B2:B13)/12

Answer: b) =AVERAGE(B2:B13)

73. Your document has 50 pages. How do you ensure each chapter starts on a new
right-hand page?

a) Insert page break

b) Use “Odd Page” section break

c) Press Enter 50 times

d) Change margins

Answer: b) Use “Odd Page” section break

74. A file named “report.odt” won’t open in MS Word. Why?

a) It’s a LibreOffice format; Word may not support it fully

b) File is corrupted

c) Word doesn’t exist

d) Requires password

Answer: a) It’s a LibreOffice format; Word may not support it fully

75. You need to send a large video file (>25 MB). What is the best method?

a) Attach to email

b) Upload to cloud and share link

c) Print and courier

d) Send via WhatsApp
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Answer: b) Upload to cloud and share link

76. After formatting a USB drive, you realize important files were on it. Can they be
recovered?

a) Never

b) Only if not overwritten

c) Always

d) Only by police

Answer: b) Only if not overwritten

77. Your computer is slow. Which is NOT a likely cause?

a) Too many startup programs

b) Low disk space

c) Using dark mode

d) Malware infection

Answer: c) Using dark mode

78. You’re on a public computer. What should you avoid?

a) Logging into personal accounts

b) Using incognito mode

c) Clearing history after use

d) Using calculator

Answer: a) Logging into personal accounts

79. Which password is strongest?

a) password123

b) P@ssw0rd!2024

c) 12345678

d) iloveyou

Answer: b) P@ssw0rd!2024

80. You receive a UPI request from an unknown VPA. What should you do?

a) Approve it

b) Reject and block

c) Call the VPA

d) Share your PIN

Answer: b) Reject and block
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Advanced True/False

81. Cache memory is faster than RAM. (True/False)

Answer: True

82. Virtual memory can be larger than physical RAM. (True/False)

Answer: True

83. HTTPS guarantees a website is safe from malware. (True/False)

Answer: False

84. UPI transactions are reversible by the user. (True/False)

Answer: False

85. Formatting a drive permanently erases all data beyond recovery. (True/False)

Answer: False

86. Cloud storage is always free. (True/False)

Answer: False

87. Incognito mode hides your activity from your ISP. (True/False)

Answer: False

88. All open-source software is free of cost. (True/False)

Answer: False

89. A firewall can prevent all types of cyberattacks. (True/False)

Answer: False

90. Biometric data can be changed if compromised. (True/False)

Answer: False

91. IPv6 has 128-bit addresses. (True/False)

Answer: True

92. The Recycle Bin uses disk space. (True/False)

Answer: True

93. Ctrl + Shift + N creates a new folder in Windows. (True/False)

Answer: True

94. PDF files cannot contain viruses. (True/False)
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Answer: False

95. UPI works without internet. (True/False)

Answer: False

96. A strong password should include uppercase, lowercase, numbers, and symbols.
(True/False)

Answer: True

97. LibreOffice is an example of proprietary software. (True/False)

Answer: False

98. The “sudo” command in Linux grants temporary admin rights. (True/False)

Answer: True

99. QR codes can execute code on your phone. (True/False)

Answer: False

100. Digital literacy includes understanding online safety and ethics. (True/False)

Answer: True

Total Questions: 100 (Advanced Level)
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